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IMPORTANT NOTICE 

All statements, technical information and recommendations in this document which relate to the 

products supplied by Meggitt Sensing Systems are based on information believed to be reliable, but 

unless otherwise expressly agreed in writing with Meggitt SA, the accuracy or completeness of such 

data is not guaranteed. Before using this product, you must evaluate it and determine if it is suitable 

for your intended application. Unless otherwise expressly agreed in writing with Meggitt SA, you 

assume all risks and liability associated with such use. Meggitt Sensing Systems takes no 

responsibility for any statements related to the product which are not contained in a current English 

language Meggitt Sensing Systems publication, nor for any statements contained in extracts, 

summaries, translations or any other documents not authored and produced by Meggitt Sensing 

Systems. 

 

 

 

EXPORT CONTROL 

The information contained in this document may be subject to export control regulations of the 

European Community, USA or other countries. Each recipient of this document is responsible for 

ensuring that the transfer or use of any information contained in this document complies with all 

relevant export control regulations. ECN N /A. 

 

 

 

COPYRIGHT 

Copyright © Meggitt SA, 2013 

All rights reserved 

Published and printed by Meggitt SA in Fribourg, Switzerland 

The names of actual companies and products mentioned  

herein may be the trademarks of their respective owners. 

The information contained in this document is subject to change without notice.  

This information shall not be used, duplicated or disclosed, in whole or in part,  

without the express written permission of Meggitt Sensing Systems. 
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PREFACE 

About these release notes 

This document provides important information about the VibroSight ® software from Meggitt Sensing 

Systems. It is applicable to all installations using the versions of VibroSight software described by this 

document, namely: 

VibroSight software version 2.9.6 (CD part number 609-004-000-016). 

This document contains information about changes to the software since the previously released 

version (VibroSight 2.9.5), such as new features and improvements, solved problems and bug fixes, 

and hardware and software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), 

refer to the following Meggitt Sensing Systems (MSS) documentation: 

 VibroSight software data sheet (MSS document ref. 660-020-005-210A) 

 Getting started with VibroSight installation guide (MSS document ref. 660-010-006-214A) 

 VibroSight help 

 VibroSight application notes and technical notes. 

Users who are familiar with previous versions of VibroSight may also find it useful to refer to the 

respective release notes included in their installation. 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the 

software modules that constitute VibroSight, such as  Configurator,  Server,  Vision and so 

on. 

You should read those sections that are most relevant to you and then keep the document for future 

reference. 

 

Version identifiers 

A complete VibroSight software product version number has four components x.x.x build x (or x.x.x.x) 

that provide the following information: 

 Major release identifier: x.x.x build x (or x.x.x.x) 

 Minor release identifier: x.x.x build x (or x.x.x.x) 

 Update identifier: x.x.x build x (or x.x.x.x) 

 Build identifier: x.x.x build x (or x.x.x.x). 
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The version identifiers for installed software appear in the Help About box (obtained using 

Help > About … in any VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt Sensing System products that can be used with the 

VibroSight software, the following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 

rack. The currently available VM600 card pairs that are designed for operation with the 

VibroSight software are the XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T. 

Where VM600 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T cards, unless otherwise stated. 

 VibroSmart DMS module or VibroSmart DMS device – to refer to VibroSight-software 

compatible modules or devices that are used in a distributed monitoring system. The currently 

available VibroSmart DMS modules and devices that are designed for operation with the 

VibroSight software are the VSI010, VSN010 and VSV300. 

Where VibroSmart DMS module is used in this document, it refers to VSI010 and VSV300 

modules, unless otherwise stated. 

Where VibroSmart DMS device is used in this document, it refers to the VSN010 device, unless 

otherwise stated. 
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1. Licensing 

In general, the licence key required to enable purchased product options remains unchanged for 

updates between patch level releases (for example, from version 2.9.5 to version 2.9.6). 

However, a new licence key is required for upgrades between major and minor version releases (for 

example, from version 2.8.x to version 2.9.6). 

To obtain a new VibroSight licence key file or for further information on licence keys, contact Meggitt 

Sensing Systems customer support. See section 7. 

 

 

2. New features 

General 

2.1. New zeroconf networking protocol implementation for discovery 

Previous versions of VibroSight used a combination of networking protocols for device discovery, that 

is, Apple ® Bonjour (itself an implementation of zeroconf) was used for the networking related to 

VibroSight hardware discovery and VibroSight Server to hardware communications, while the 

universal plug and play (UPnP) networking protocols were used for the networking related to 

VibroSight software module discovery and inter-module communications. 

However, as these networking protocols were not working reliably – especially on computers running 

Windows XP – the Apple Bonjour and UPnP networking protocols have been replaced by a proprietary 

implementation of the zero configuration networking (zeroconf) protocols. This new implementation of 

the zeroconf protocols is now used for all required networking operations in order to ensure more 

reliable device discovery and communications. 

NOTE: Starting with VibroSight 2.9.6, Apple Bonjour for Windows is no longer a 

prerequisite for VibroSight. 

 

In addition, the VibroSight Server selection dialog boxes have been improved to allow the IP address 

and port information for a VibroSight Server available (running) on the network to be typed into the 

dialog box in order to select a particular VibroSight Server, even if it is not listed. See section 2.2. 

 

2.2. Connecting to a VibroSight Server using a manually specified IP address 

Due to certain network configurations or limitations of the underlying zero configuration networking 

(zeroconf) protocols, the VibroSight Server selection dialog boxes used to select a particular 

VibroSight Server do not always list all of the server instances available (running) on the network. 

Consequently, the IP address and port information for a VibroSight Server available (running) on the 

network is now available from the VibroSight Server itself or VibroSight System Manager: 

 In a VibroSight Server, the IP address and port of a VibroSight Server is now displayed on the 

main VibroSight Server window under Connection Info. 
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 In VibroSight System Manager, the IP address and port of a VibroSight Server available 

(running) on the network is now displayed under Connection Info in the Information pane that 

is available when a VibroSight Server is selected for a host computer listed in the VibroSight 

Hosts view. 

This IP address and port information can be typed into the improved VibroSight Server selection 

dialog boxes to manually specify a particular VibroSight Server to connect to and work with (even if it 

is not listed). 

NOTE: In order to connect to a VibroSight Server using a manually specified IP address 

when Windows Firewall is enabled on the computer, VibroSight Server should be 

selected in the list of allowed programs (the exceptions list) in Windows Firewall 

and/or the TCP port used by the VibroSight Server should be added to the 

exceptions list. 

In addition, incoming Internet Control Message Protocol (ICMP) echo requests 

must also be enabled. 

 

2.3. Availability of VibroSight database script files to start VibroSight 
databases 

VibroSight database script files (a collection of Windows batch files) are now distributed with 

VibroSight in order to enable the quick analysis of VibroSight databases. 

The VibroSight database scripts are used to start a VibroSight Server for a database without having to 

manually create a database source name (DSN) for the database. Different VibroSight database 

scripts (*.bat) are available depending on the Windows operating system (32-bit or 64-bit), intended 

use of the VibroSight Server (Offline or Online) and the amount of RAM installed on the computer. 

When the VibroSight database scripts are used, a system database source name (DSN) of either 

Offline01 or Online01 (depending on the particular script file used) is automatically created for a 

database, so no manual DSN generation is required. Then a VibroSight Server will automatically start 

and open the database with the parameters defined in the batch file. The fixed DSNs (Offline01 or 

Online01) allow generic VibroSight Vision projects that use these DSNs to start working with the 

databases immediately. 

 

 

 VibroSight System Manager 

2.4. Refreshing Devices and VibroSight Hosts views 

In the System Explorer tree structure, VibroSight-compatible devices are displayed in the Devices 

view, while VibroSight host computers and VibroSight Servers are displayed in the VibroSight Hosts 

view (for devices and hosts on the same network as the computer running System Manager). These 

views are automatically updated whenever there is a networking event, such as a device being added 

to or removed from the network. However, due to limitations of the underlying zero configuration 

networking (zeroconf) protocols, the views can take some minutes to be updated. 



     

   
 

 

     

 

     
 10 / 32  Release Notes VIBROSIGHT-RN/E 

Release 2.9.6 – April 2013 
 

     
 

A new Refresh button has been added to the toolbar at the top of the Devices and the 

VibroSight Hosts views in order to allow the items displayed to be manually updated at any time. 

Similarly, both views (lists) can be updated at the same time using a new Refresh command on the 

View menu (View > Refresh) or by pressing the F5 key. (Note: It still takes some time for the items 

displayed to be updated.) 

 

2.5. Summarising the contents of a VibroSight database 

The contents of a VibroSight database can now be summarised in one of two ways: 

 Using the database extract summary tool in VibroSight System Manager. 

 Using the equivalent command-line tool. 

NOTE: The information included in the summary file generated by the database extract 

summary tool is exactly the same as the information included in the summary file 

generated by the database copy wizard (for the same database and time range). 

 

 

 VibroSight Vision 

2.6. Improved plot property defaults 

Some default plot properties have been changed in order to improve usability: 

 For all plots that have a y-axis, the default y-axis range scaling has been changed to Auto Scale 

(it was Full Display Range). 

 For Waterfall / Cascade plots, the default y-axis range scaling has been changed to Auto Scale 

(it was Full Display Range). 

 For Waterfall / Cascade plots, the default depth (that is, the live data conservation option) has 

been changed to 60 minutes or 60 items, whichever comes first (it was 1 minute or 50 items, 

whichever comes first). 

 

 

  



     

 
 

   

     

 

     
 Release Notes VIBROSIGHT-RN/E 

Release 2.9.6 – April 2013 
 11 / 32  

     
 

3. Solved problems and bug fixes 

 VibroSight System Manager 

3.1. Actions window not displaying all of the tools that should be available 

The Actions window was not displaying all of the group boxes (tools) such as VibroSight Server, OPC 

Server and Modbus Server, all of the time (an intermittent problem). 

This problem was related to the general device discovery problems that have been corrected. See 

section 2.1. 

 

3.2. IP Settings in Configuration tools appear intermittently 

The Configuration group box (tools) in the Actions window did not always display the IP Settings tool. 

This bug has been corrected. 

 

3.3. Failure to publish a VibroSight OPC Server 

System Manager fails to publish an OPC Server and displays an OPC Server Publishing Failed error 

message on computers where the 64-bit version of the Microsoft Visual C++ Redistributable Package 

is installed. This is because the VibroSight OPC server is a 32-bit application and therefore requires 

that the 32-bit version of the package (vcredist_x86.exe) is installed. 

To avoid confusion, the 64-bit version of the Microsoft Visual C++ Redistributable Package has been 

removed from the Prerequisites folder of the VibroSight CD. In addition, before attempting to publish 

an OPC Server, VibroSight System Manager now performs a check to ensure that the 32-bit version of 

the package is installed, displays a message to the user if it is not and records this information in the 

System Manager log file. 

 

3.4. Host Service Stop command 

Stopping the VibroSight Host Service (using the Stop command in the Host Service group box) before 

System Manager had finished updating the VibroSight Hosts tree structure of the System Explorer 

window resulted in a message telling the user that the stop command was not completed (“The 

service did not respond in a timely fashion. Please consult the Windows Event Log or try again.”), 

even though the VibroSight Host Service had in fact stopped, while the Start/Stop command in the 

Host Service group box remained available as a Stop command. 

NOTE: The Host Service Stop/Start command is a toggle command, that is, only the Stop 

command is visible when the VibroSight Host Service is running and only the Start 

command is visible when the VibroSight Host Service is stopped. 
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 VibroSight Configurator 

3.5. Improved consistency check for VibroSmart VSI010 module Profibus slots 
that are configured as Profisafe 

The consistency check tool has been improved in order to ensure that a VSI010 module’s fieldbus port 

configured as a Profibus port using Profisafe slots (that is, with the ProfiSafe parameter enabled) is 

fully compatible with the PROFIsafe specification from PROFINET International (PI). 

 

3.6. Unable to save a configuration as a server/database 

It a configuration was opened from a server/database (File > Open > Server/Database), it was not 

possible to save the configuration as a server/database (File > Save As > Server/Database). This 

bug has been corrected. 

 

3.7. Unable to exit Configurator if the connection to the Server is lost 

It a configuration was opened from a server/database (File > Open > Server/Database) and the 

connection to the Server was lost, a Server Connection dialog box appeared with the message 

“Please wait unto the connection recovers” and prevented Configurator from being exited as normal. 

Consequently, either the VibroSight Server had to be restarted and the connection with Configurator 

re-established before Configurator could be exited or the Configurator process had to be ended using 

a tool such as Windows Task Manager. This bug has been corrected. 

 

3.8. Incorrect calculation of full display range values for dynamic processing 
block extracted data 

The full display range values (Full Display Range: Maximum Value and Minimum Value) calculated 

for the extracted data (measurements) for dynamic processing blocks were wrong for the spectra 

outputs and for the measurements based on the spectra outputs. The full display range values are 

now correctly calculated based on the Physical Quantity, Input Range and Sensitivity configured for 

the dynamic input channel, so this bug has been corrected. 

 

3.9. Incorrect calculation of maximum full display value for a dynamic 
processing block’s spectrum output 

The maximum full display values (Max Full Display) calculated for the default Spectrum output 

(Spectra And Waveforms parameters) for dynamic processing blocks were wrong by a multiple of 

power of ten. This bug has been corrected. 

 

3.10. Maximum full display values for a dynamic processing block’s spectrum 
output cannot be changed 

When Integration was changed to none and Use Full Display Custom Values was selected 

(Spectra And Waveforms parameters) for dynamic processing blocks, the maximum full display (Max 
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Full Display) text boxes and drop-down list boxes remained unavailable (greyed out) and could not be 

changed from their existing values. This bug has been corrected. 

 

3.11. Unable to connect to a local server/database 

Opening a server/database (File > Open > Server/Database) from a local VibroSight Server, that is a 

Server running on the same computer as the Configurator, was occasionally not possible. For 

example, due to a VibroSight Software - InvalidOperationException (unhandled error) when a server 

was selected from the list of available servers in the VibroSight Server selection dialog box, or the list 

of available servers in the VibroSight Server selection dialog box remaining empty. 

This problem was related to the general device discovery problems that have been corrected. See 

section 2.1. 

 

 

 VibroSight Server 

3.12. Device discovery problems 

A VibroSight Server could stop responding (“crash”) after experiencing problems on the network (for 

example, due to a loss of communications between the server and VM600 cards), providing an 

XmsServerGUI message such as “XmsServerGUI has encountered a problem and needs to close”. 

This problem was related to the general device discovery problems that have been corrected. See 

section 2.1. 

 

 

 VibroSight Vision 

3.13. General issues with projects 

Previously, VibroSight Vision projects were automatically saved on a periodic basis, in the 

background, to help ensure that the changes to a project were not lost if Vision stopped responding 

(“crashed”) for any reason. 

This behaviour has been changed so that projects are no longer automatically saved and it is the 

responsibility of the user to save any changes to their Vision projects. In general, it is recommended 

that File > Save All is used, even if no documents have been changed, in order to ensure that the 

arrangement of the windows (window layout) is also saved. 

 

3.14. Mimic value indicators not being displayed correctly because of alarm 
limits 

When alarm limits were configured for extracted data (measurements), some corresponding value 

indicators in Mimics were not always displayed correctly, as the alarm limits for the measurement were 
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being used in addition to the full display range in order to calculate the display range for the value 

indicator. 

This behaviour has been changed so the display range for a value indicator is based only on the full 

display range configured for the extracted data, so this bug has been corrected. 

If the measured value is greater than the maximum display range of the value indicator, the colour of 

the upper section of the value indicator will reflect the severity level corresponding to the measured 

value (even if this severity level is not displayed on the value indicator because it is outside the full 

display range). 

If the measured value is less then than the minimum display range of the value indicator, the colour of 

the upper section of the value indicator will be white to highlight this fact. 

 

3.15. Mimic value indicators not being displayed correctly after the maximum 
display range exceeded 

If the measured value displayed by a value indicator in a Mimic was greater than the value indicator’s 

maximum display range, then the colour of the upper section of the value indicator could remain the 

colour of the severity level corresponding to this measured value, even after the measured value 

returned to a value within the display range. That is, the colour of the upper section of the value 

indicator could stop reflecting the currently measured value. This bug has been corrected. 
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4. Known issues 

4.1. VibroSight Server and Host Service restart required after changes to 
network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or 

disconnected) on a computer running VibroSight, then the VibroSight Servers and Host Services 

running on the computer must be restarted in order for the network adapter to be recognized by the 

VibroSight discovery mechanism. 
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5. Compatibility 

NOTE: Refer also to the latest version of the  Getting started with VibroSight 

installation guide or the  VibroSight software data sheet for further information 

on VibroSight’s prerequisites and compatibility. 

 

5.1. VibroSight software 

VibroSight 2.9.6 is a minor version release in the 2.x.x series and replaces VibroSight 2.9.5. 

Compatibility with existing databases is achieved using the database  Update tool (from 

VibroSight System Manager’s  Database tools) which supports the continued used of 

configurations and data from previous versions. See section 6.1.1. 

 

5.1.1. Microsoft Windows operating systems 

VibroSight 2.9.6 is compatible with 32-bit versions and 64-bit versions of Microsoft ® Windows ® 

operating systems. 

NOTE: Since VibroSight 2.9.0, VibroSight can run on 64-bit versions of Windows in order 

to help eliminate memory and performance issues that can occur due to the 

limitations of the 32-bit memory space. 

However, VibroSight 2.9.6 is 32-bit software that runs on x64 Windows in the same 

manner as it does on 32-bit windows, that is, VibroSight is "x64-compatible" 

software (not "native x64" software). 

 

See the appendix of this document for detailed information on VibroSight software and Windows 

operating system compatibility. 

 

5.1.2. Microsoft .NET Framework 

For most Windows operating systems, VibroSight 2.9.6 requires that the Microsoft .NET Framework 

4.5 is installed on the computer.  

NOTE: Microsoft .NET Framework 4.5 is required since VibroSight 2.9.4. 

Microsoft .NET Framework 4 (Standalone Installer) is required for VibroSight 2.9.2 

and 2.9.3. 

Microsoft .NET Framework 3.5 SP1 is required for VibroSight 2.9.1 or earlier. 

 

See the appendix of this document for detailed information on VibroSight software’s Microsoft .NET 

Framework requirements. 
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5.1.3. Apple Bonjour 

Starting with VibroSight 2.9.6, Apple ® Bonjour is no longer required, as a proprietary implementation 

of the zero configuration networking (zeroconf) protocols is now used for all required networking 

operations: VibroSight hardware (VM600 cards and VibroSmart DMS modules and devices) and 

software module discovery, VibroSight Server to hardware communications and inter-module 

communications. 

NOTE: Starting with VibroSight 2.9.6, Apple Bonjour for Windows is not required and may 

be uninstalled (if it is not required by other software installed on the computer 

running VibroSight). 

Apple Bonjour for Windows version 3.0 should be used with VibroSight 2.8.x to 

VibroSight 2.9.5. 

Apple Bonjour for Windows version 1.0.106 should be used with VibroSight 2.7.x or 

earlier. 

The 64-bit version of Bonjour must be installed on 64-bit Windows operating 

systems. 

 

5.1.4. Sybase SQL Anywhere 11 software 

VibroSight uses the Sybase ® SQL Anywhere 11 database software in its standard configuration. 

VibroSight 2.9.6 remains compatible with the previously deployed version of SQL Anywhere, namely 

SQL Anywhere version 11.0.1.2044. 

NOTE: VibroSight requires the 32-bit version of SQL Anywhere 11 on both 32-bit and 64-

bit Windows operating systems. 

It is strongly recommended that only the 32-bit version of SQL Anywhere 11 is 

installed on the computer running VibroSight. 

 

NOTE: Updating SQL Anywhere to version 11.0.1.2867 is mandatory in order to avoid 

potential memory issues (fixed by Sybase). A software update (patch) included on 

the Sybase CD must be run in order to update Sybase SQL Anywhere from version 

11.0.1 to version 11.0.1.2867: SA11_Full_Win32+x64.1101_2867_EBF.exe. See 

section 6.2. 

 

 (If Sybase SQL Anywhere 11 is not updated to version 11.0.1.2867, VibroSight 2.9.6 will still run but a 

warning message will be displayed by the VibroSight Server.) 
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5.1.5. Microsoft Visual C++ Redistributable Package 

If a VibroSight OPC Server is to be used, VibroSight 2.9.6 requires that the Microsoft Visual C++ 

Redistributable Package is installed on the computer, in order to install and register the Visual C++ 

libraries used by VibroSight OPC servers. 

NOTE: The Microsoft Visual C++ Redistributable Package is required since 

VibroSight 2.9.4, if OPC servers are being used. 

The 32-bit version of the package (“vcredist_x86.exe”) must be installed on both 

32-bit and 64-bit Windows operating systems, as the VibroSight OPC server is a 

32-bit application. 

 

5.1.6. OPC Foundation OPC Core Components Redistributable 

If a VibroSight OPC Client or OPC Server is to be used, VibroSight 2.9.6 requires that the OPC Core 

Components Redistributable from the OPC Foundation is installed. The redistributable must be 

installed on OPC client computers in order to allow connections to remote OPC servers and it must be 

installed on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The OPC Core Components Redistributable is required since VibroSight 2.9.4, if 

OPC clients or OPC servers are being used. 

The 32-bit version of the package (“OPC Core Components Redistributable (x86)”) 

must be installed on 32-bit Windows operating systems and the 64-bit version of 

the package (“OPC Core Components Redistributable (x64)”) must be installed on 

64-bit Windows operating systems. 

 

 

5.2. VibroSight hardware 

5.2.1. VM600 card firmware 

There are no new firmware (embedded software) updates for the VM600 cards corresponding to 

VibroSight 2.9.6. 

The latest firmware for the CPUR card remains: 

 Applications:  applications-640-012-001-003.tgz 

 Base System: base-system-640-011-001-003.tgz. 

The latest firmware for the XMC16, XMV16 and XMVS16 cards remains: 

 Applications:  applications-640-010-001-006.tgz 

 Base System: base-system-640-003-001-007.tgz. 

Therefore, for current versions of the XMC16, XMV16 and XMVS16 cards, no firmware upgrades are 

required. 
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5.2.2. VibroSmart DMS device firmware 

There are new firmware (embedded software) updates for the VibroSmart DMS modules and devices 

corresponding to VibroSight 2.9.6. 

The latest firmware for the VSI010 module is: 

 642-002-001-002.xmsifw. 

The latest firmware for the VSN010 device is: 

 642-004-001-002.redboxfw. 

The latest firmware for the VSV300 module is: 

 642-001-001-003.xtranfw. 

Therefore, for earlier versions of the VibroSmart DMS modules and devices, a firmware upgrade is 

required (see section 6.3.2). 
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6. Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. 

Perform the steps in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (VM600 cards and VibroSmart DMS modules and devices) before 

starting a VibroSight system upgrade, in order to establish if any firmware updates 

are also required. See section 6.3.3. 

 

6.1. Upgrading the VibroSight software 

NOTE: Starting with VibroSight 2.9.6, VibroSight Server instance names are limited to 

18 characters (previously, it was 27). So VibroSight installations with VibroSight 

Server instance names of more than 18 characters will experience problems with 

VibroSight 2.9.6 until the existing VibroSight Server instance names (and any 

references to them) are manually edited to be 18 characters or less. 

 

1. If it is not necessary for the VibroSight-based system to remain operational during the upgrade 

procedure, back up any important (required) VibroSight databases in the following way: 

 Exit all VibroSight software modules (clients and servers) – no VibroSight software modules, 

such as Vision, Configurator or Server, should be running. 

 Copy the three files (*.db, *.config and *.log) from the directory where your 

database files are located to another location, for example, to a specific backup directory. 

 NOTE: The default data (data path) directory is C:\VibroSight Data 

 

Or if it is necessary for the VibroSight-based system to remain operational for as long as 

possible during the upgrade procedure, back up any important (required) VibroSight databases 

in the following way: 

 Exit all VibroSight software modules (clients) – no VibroSight software modules, such as 

Vision or Configurator, should be running. 

 Start VibroSight System Manager and use the database  Backup tool from VibroSight 

System Manager’s  Database tools, and follow the instructions presented by the 

Database Backup Wizard. 

 NOTE: It is necessary to be logged in to System Manager as ‘Admin’ in order to have the 

user rights to access the database tools: 

Select your  VibroSight Host (computer) in the System Explorer tree structure 

and click  Login (from VibroSight System Manager’s  Access Rights 

tools). 
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 NOTE: Refer also to the Backing up a database topic in the  VibroSight help. 

 

2. Make backup copies of any important (required) VibroSight Vision projects in the following way: 

 Create an archive file (for example, *.zip) containing all of the files (*.xml and 

*.xmsproj) in the directory where your project files are located. 

 NOTE: The default project directory is: 

C:\Documents and settings\username\My Documents 

\VibroSight\Projects 

 

3.  Ensure that no VibroSight software modules are running. 

4. Remove the currently installed version of the VibroSight software (for example,  

 VibroSight Standard Edition) using Windows Add or Remove Programs, in one of the 

following ways: 

 Click Start > Settings > Control Panel and then double-click Add or Remove Programs. 

 Or click Start, click Control Panel and then double-click Add or Remove Programs. 

5. Install the latest version of the VibroSight software by inserting the VibroSight CD into the 

CD/DVD drive of the computer and follow the instructions presented by the VibroSight 

installation wizard. 

NOTE: Refer to the  Getting started with VibroSight installation guide for detailed 
information on installing the VibroSight software – including prerequisites and 
compatibility. 

 

6. Restart VibroSight Server and ensure that the required communications are enabled. For 

example, enable card and module device drivers according to the hardware in the system: 

 For example, click Data > Acquisition > XMC16/XMV16 Card Driver or 

Data > Acquisition > VibroSmart Module Driver. 

7. Restart VibroSight Vision and ensure that live data is being received from the hardware and 

displayed in Vision. 

8. The VibroSight system is now up and running. 
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6.1.1. Updating the internal structure of a VibroSight database 

When VibroSight Server is started, it checks the status of the database and will automatically inform 

the user if any internal structures of the database need to be updated before proceeding. 

1. Update a VibroSight database in the following way: 

 Start VibroSight System Manager and use the database  Update tool from VibroSight 

System Manager’s  Database tools, and follow the instructions presented by the 

Database Update Wizard. 

 

 NOTE: It is necessary to be logged in to System Manager as ‘Admin’ in order to have the 

user rights to access the database tools: 

Select your  VibroSight Host (computer) in the System Explorer tree structure 

and click  Login (from VibroSight System Manager’s  Access Rights 

tools). 

 NOTE: Refer also to the Updating a database topic in the  VibroSight help. 

 

 

6.2. Upgrading the Sybase SQL Anywhere 11 software 

VibroSight software is compatible (and extensively tested) with Sybase SQL Anywhere versions 

11.0.0 and 11.0.1. 

However, with the release of SQL Anywhere version 11.0.1.2867, Sybase has fixed some previously 

known memory issues. Therefore, it is mandatory to upgrade all VibroSight systems to this version of 

SQL Anywhere 11. 

 

Determine the version of the SQL Anywhere 11 database engine installed on a computer in the 

following way: 

1. From the Start menu, click Start > All Programs > SQL Anywhere 11 > Sybase Central. 

The Sybase Central window appears. Sybase Central is a GUI-based management tool for 

Sybase products. 

2. Click Help > About Sybase Central. 

The About Sybase Central windows appears, displaying the version information for SQL 

Anywhere 11 (and any other installed Sybase products). 

 NOTE: Refer also to the Determining the version of SQL Anywhere 11 installed on a 

computer topic in the  VibroSight help. 
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If SQL Anywhere 11 version 11.0.0 is installed on the computer, it is necessary to first remove 

version 11.0.0, then install version 11.0.1 from the Sybase CD. 

If SQL Anywhere 11 version 11.0.1 is installed on the computer, simply update to version 11.0.1.2867 

by running the software update (patch) included on the Sybase CD. 

When SQL Anywhere 11 software version 11.0.0 is installed on the computer: 

NOTE: Do not use the SQL Anywhere 11.0.1 setup to upgrade directly to software version 

11.0.1 from software version 11.0.0. Instead, it is necessary to upgrade the Sybase 

database software as follows: 

1. Remove SQL Anywhere 11.0.0, using the Windows Add or Remove Programs 

tool. 

2. Install SQL Anywhere 11.0.1, using the Sybase SQL Anywhere 11.0.1 CD. 

Refer also to the  Getting started with VibroSight installation guide for 

information on installing the Sybase software. 

 

1. Exit all VibroSight software modules (clients and servers) – no VibroSight software modules, 

such as Vision, Configurator or Server, should be running – as this also stops the SQL 

Anywhere 11 database engine. 

The  lightning icon that appears in the notification area (at the far right of the task bar) to 

indicate that a Sybase database engine is running should no longer be shown. 

2. Remove the currently installed version of Sybase SQL Anywhere 11 using Windows Add or 

Remove Programs, in one of the following ways: 

 Click Start > Settings > Control Panel, then double-click Add or Remove Programs 

 Or click Start, click Control Panel and then double-click Add or Remove Programs. 

And remove  SQL Anywhere 11. 

3. Restart the computer. 

4. Install Sybase SQL Anywhere VibroSight 11.0.1.2044 by inserting the Sybase CD into the 

CD/DVD drive of the computer and following the instructions presented by the 

SQL Anywhere 11 installation wizard. 

5. Restart the computer. 

Without this final computer restart, VibroSight Server may not be able to start the 

SQL Anywhere 11 database engine. 
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When SQL Anywhere 11 software version 11.0.1 is installed on the computer: 

1. Update to Sybase SQL Anywhere VibroSight 11.0.1.2867 by inserting the Sybase CD into the 

CD/DVD drive of the computer, running the SA11_Full_Win32+x64.1101_2867_EBF.exe 

software update (patch) and following the instructions presented by the SQL Anywhere 11 

installation wizard. 

2. Restart the computer. 

 

6.3. Updating the VibroSight hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (CPUR, 

XMC16, XMV16 and XMVS16) and VibroSmart DMS devices (VSI010, VSN010 and VSV300) to be 

updated to the latest standard, in order to take advantage of improvements to the VibroSight software. 

 

6.3.1. VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the 

VibroSight installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight 2\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their 

.tgz file name extension. For example, the XMV16 subfolder contains the applications and base 

system firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt 

Sensing Systems should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600 card hardware (that is, 

XMC16, XMV16 and XMVS16 card pair firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 card 

firmware that is compatible with the version of VibroSight software being used. 
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Table 1: VibroSight software and VM600 card firmware compatibility 

 VM600 card firmware 

VibroSight client-

server software 

(VibroSight version 

CD part number) 

Applications- 

640-004- 

001-003.tgz 

Base-system- 

640-003- 

001-001.tgz 

Applications- 

640-010- 

001-001.tgz 

Base-system- 

640-003- 

001-002.tgz 

Applications- 

640-010- 

001-002.tgz 

Base-system- 

640-003- 

001-003.tgz 

Applications- 

640-010- 

001-003.tgz 

Base-system- 

640-003- 

001-004.tgz 

Applications- 

640-010- 

001-004.tgz 

Base-system- 

640-003- 

001-005.tgz 

Applications- 

640-010- 

001-005.tgz 

Base-system- 

640-003- 

001-006.tgz 

Applications- 

640-010- 

001-006.tgz 

Base-system- 

640-003- 

001-007.tgz 

1.0.0 

609-004-000-001 
       

2.0.0 

609-004-000-003 
  

  
   

2.0.5 

609-004-000-004 
  

  
   

2.0.6 

609-004-000-005 
  

  
   

2.5.0 

609-004-000-006 
  

  
   

2.7.5 

609-004-000-008 
   

 
   

2.8.0 

609-004-000-007 
   

 
   

2.9.0 

609-004-000-010 
 

  
    

2.9.1 

609-004-000-011 
       

2.9.2 

609-004-000-012 
       

2.9.3 

609-004-000-013 
       

2.9.4 

609-004-000-014 
       

2.9.5 

609-004-000-015 
       

2.9.6 

609-004-000-016 
       
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6.3.2. VibroSmart DMS device firmware 

The latest VibroSmart DMS device firmware files are copied to a directory on your computer as part of 

the VibroSight installation process. 

NOTE: The default firmware directory for VibroSmart DMS devices is: 

C:\Program Files\Meggitt\VibroSight 2\Firmware\VibroSmart 

 

The firmware files for a VibroSmart DMS device can be found in the appropriate subfolder and 

identified by their .*fw file name extension. For example, the VSV-300 subfolder contains the 

firmware for use by VSV300 modules. Any additional firmware updates received from Meggitt Sensing 

Systems should also be stored in these directories. 

Table 2 shows the compatibility between VibroSight software and VibroSmart DMS device hardware 

(that is, VSI010, VSN010 and VSV300 device firmware).  

NOTE: It is strongly recommended to use the most recent version of the VibroSmart DMS 

device firmware that is compatible with the version of VibroSight software being 

used. 
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Table 2: VibroSight software and VibroSmart DMS device firmware compatibility 

 VibroSmart DMS device firmware 

VibroSight 

client-server 

software 

(VibroSight 

version 

CD part number) 

VSI010 VSN010 VSV300 VSV310 

2.8.0 

609-004-000-007 

642-002-001-

001.xmsifw 

642-004-001-

001.redboxfw 

642-001-001-

001.xtranfw 

Not available yet 

2.9.1 

609-004-000-011 

642-002-001-

001.xmsifw 

642-004-001-

001.redboxfw 

642-001-001-

002.xtranfw 

Not available yet 

2.9.2 

609-004-000-012 

642-002-001-

001.xmsifw 

642-004-001-

001.redboxfw 

642-001-001-

002.xtranfw 

Not available yet 

2.9.3 

609-004-000-013 

642-002-001-

001.xmsifw 

642-004-001-

001.redboxfw 

642-001-001-

002.xtranfw 

Not available yet 

2.9.4 

609-004-000-014 

642-002-001-

001.xmsifw 

642-004-001-

001.redboxfw 

642-001-001-

002.xtranfw 

Not available yet 

2.9.5 

609-004-000-015 

642-002-001-

001.xmsifw 

642-004-001-

001.redboxfw 

642-001-001-

002.xtranfw 

Not available yet 

2.9.6 

609-004-000-016 

642-002-001-

002.xmsifw 

See note 1 

642-004-001-

002.redboxfw 

642-001-001-

003.xtranfw 

Not available yet 

 

Notes for Table 2 

1. VSI010 firmware version 642-002-001-002.xmsifw is only compatible with VibroSight 2.9.6. 
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6.3.3. Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade 

the firmware of VM600 cards and VibroSmart DMS devices to the latest compatible version. 

Failure to perform a necessary VibroSight card firmware update may lead to incoherent system 

behaviour and affect the proper functioning of data acquisition in a system. It is only in systems where 

the firmware running on the VM600 cards and VibroSmart DMS devices already corresponds to the 

latest available version that no firmware update is required. Therefore, it is strongly recommended to 

verify the version of firmware running on the hardware before starting a VibroSight system upgrade, in 

order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight 

System Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the 

hardware (VM600 card or VibroSmart DMS module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System 

Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the 

network. If there are no VM600 cards or VibroSmart DMS devices in the tree structure or some 

cards are missing, verify your network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the 

device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VM600 card or VibroSmart DMS device selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart DMS devices. 
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6. Click the Finish button to start the firmware upgrade process. 

For VM600 cards and VibroSmart DMS devices, the firmware upgrade process can take up to 

5 minutes, during which: 

 The IP address beside the device’s serial number in the Devices tree structure can 

disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update.  

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of 

firmware. It is therefore possible to change a device’s firmware to any previously available version, as 

well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware 

between different VM600 racks or VibroSmart DMSs, where systems are operating with different 

versions of VibroSight. 

 

 

6.4. Final check 

After upgrading the VibroSight software, it is recommended to open the configuration and run a 

consistency check in order to ensure that the configuration has not been inadvertently modified by any 

changes to the VibroSight software, internal database structure and firmware for the hardware (VM600 

cards and VibroSmart DMS modules). 
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7. Customer support 

7.1. Contacting us 

Meggitt Sensing Systems worldwide customer support network offers a range of support including 

Technical support and Sales and repairs support. For customer support, please contact your local 

Meggitt Sensing Systems representative. Alternatively, contact our main office: 

Customer support 

Meggitt SA 

Route de Moncor 4 

PO Box 1616 

CH-1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Web: www.meggittsensingsystems.com 

 

7.2. Technical support 

Meggitt Sensing Systems technical support team provide both pre-sales and post-sales technical 

support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3. Sales and repairs support 

Meggitt Sensing Systems sales team provide both pre-sales and post-sales support, including advice 

on: 

 New products 

 Spare parts 

 Repairs. 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensingsystems.com/
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VibroSight software and Windows operating system compatibility 

 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

VibroSight software 

compatible? 

Yes, but not recommended for 

new installations as Microsoft 

support for Windows XP SP3 

ends on 08 April 2014 

Yes, but not recommended. 

Windows Server 2008 R8 

should be used instead of 

Windows Server 2008 

Yes – recommended for new 

installations 
To be announced 

 

Microsoft .NET Framework versions pre-installed on Windows operating systems 

 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

Microsoft .NET Framework 

pre-installed on Windows 

operating system 

None on XP. 

.NET Framework 2.0 on 

Server 2003 R2 

.NET Framework 3.0 .NET Framework 3.0 SP1 .NET Framework 4.5 

 

VibroSight software’s Microsoft .NET Framework requirements 

VibroSight software version 
Windows XP and 

Windows Server 2003 R2 

Windows Vista and 

Windows Server 2008 

Windows 7 and 

Windows Server 2008 R2 

Windows 8 and 

Windows Server 2012 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 .NET Framework 3.5 SP1 

VibroSight 2.9.2 and 2.9.3 .NET Framework 4 .NET Framework 4 .NET Framework 4 .NET Framework 4 

VibroSight 2.9.4 or later .NET Framework 4
 1
 .NET Framework 4.5 .NET Framework 4.5 .NET Framework 4.5 

 


